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1. Copyright Notice

© Copyright 2012 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BVBA. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BVBA does not warrant, guarantee or make any representations
regarding the use, or the results of the use of the software or the information contained herein. Esko
Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising
out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published,
in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other
means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other
trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly
owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2012. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.
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The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by BestTM Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com
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2. Installing ai-cut

2.1 Compatibility

The ai-cut product is compatible with Adobe Illustrator versions CS5, CS5.5 and CS6 on both Mac
and PC.

2.2 Installation

Below you find the installation instructions for Windows and Mac.

Users who have manually installed previous release ai-cut 1.1 version on mac and win, should remove
the ai-cut plugin first. Otherwise you may get two version of the ai-cut plugin on Illustrator CS5.

You can verify that the installation was successful, by locating your Illustrator Toolbar and verifying
that the i-cut eye icon is present just below the Eyedropper tool.

2.2.1 Installing ai-cut on Windows

1. Shut down Adobe Illustrator

2. Unzip the file you downloaded (ai-cut_win_1_2.zip).
This creates a folder ai-cut_win_1_2 containing the ai-cut Installer, a note and the release
notes, which list the system requirements, new features and known limitations of the plug-in.

3. Double-click the package installer and follow the instructions on screen. The plug-in is installed
in the Esko folder which is inside Illustrator's Plug-Ins folder.

4. Launch Adobe Illustrator.

2.2.2 Installing ai-cut on Mac

1. Shut down Adobe Illustrator

2. Double-click the file you downloaded (ai-cut_mac_1_2.dmg).
This opens a window containing the package installer ai-cut.pkg, a note and the release notes,
which list the system requirements, new features and known limitations of the plug-in.

3. Double-click the package installer and follow the instructions on screen. The plug-in is installed
in the Esko folder which is inside Illustrator's Plug-Ins folder.

4. Launch Adobe Illustrator.
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3. Using ai-cut

The file used in the examples throughout this section is included in the ai-cut download package.
To better understand the features explained in the section it will definitely be helpful for new users
to re-create these examples using the provided file.

3.1 Locating the provided plug-in tools

As mentioned in the installation section, the plug-in adds an icon to the Illustrator toolbar.

The i-cut Register Mark tool works in exactly the same manner as any other button on the toolbar.
Left-click and hold expands the button, while clicking the arrow to the right of the expanded button
creates a floating palette.

Double-clicking the button opens the i-cut Register Marks window, which contains options related
to the tool.

In  Window > Esko > ai-cut , you find the remaining ai-cut tools: Add i-cut Layer, Add i-cut Register
Marks (same window as accessed by double-clicking the toolbar button) and Preflight for i-cut.

3.2 Inserting Registration Marks

3.2.1 Inserting Regmarks manually

Your mouse pointer will change appearance to reflect your tool selection.

Note:  Turning on Illustrator’s Use Precise Cursors option will produce a crosshair pointer instead
of a representation of the selected Regmark tool.

Clicking anywhere in your work area will produce an i-cut regmark, which is automatically placed
into a newly generated Regmark layer.

Select the filled or reversed mark from the toolbar tool and notice the difference when inserting the
marks.
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Once marks are inserted, they may be moved, deleted or modified just like any other curve in
Illustrator.

3.2.2 Setting Regmark Appearance and Action Parameters

To set regmark appearance parameters, open the i-cut Register Marks window by either double-
clicking the toolbar button, or by selecting  Window > Esko > ai-cut > Add i-cut Register Marks .
The Appearance section at the top of the window provides several parameters that dictate regmark
appearance. The Action section of the window defines the action that will be taken when exiting the
i-cut Register Marks window.

Type:

The selection of Type coincides with the two types of marks available from the toolbar. Notice when
you select one type or another and exit the window, the toolbar button changes accordingly.

Filled marks are used in most cases and provide the best contrast on nearly all materials.

Reversed marks are often used when printing on reflective surfaces, to help provide additional
contrast by using the printed ink to mask the material on which it is printed.

Diameter & Outer Diameter:

These two parameters control the size of the regmarks. Outer diameter is only available when using
the reversed mark type.

Colors

Clicking the Use Current button will change the color of the regmarks to the currently selected color,
which is displayed in the Fill box on the toolbar. In order to be used, this color must be a CMYK or
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RGB color and cannot be a gradient, spot color or other type of fill. If you would like to use one of
these other fill types, such as a spot color, apply it to the marks after you have inserted them.

Add Marks Manually

Selecting this option will apply all changes made to appearance parameters to the i-cut Register
Mark manual insertion tool.

Add Corner Marks

If this option is selected, ai-cut will generate a single set of corner marks around the entire visible
contents of the file. It will automatically generate two marks in one of the corners to help avoid
confusion when cutting nearly symmetrical layouts.

Add Auto Marks

Add Auto Marks intelligently places multiple register marks within the limits of the Illustrator Artboard
(defined in the document setup). Exact positions of the marks are determined relative to the visible
contents of the file. The number of marks is set using the Quantity slider, which becomes available
as soon as the option is selected. The exact number of marks depends on the size of the Artboard
and the visible contents of the file. Moving the slider to the left decreases the number of marks, while
moving it to the right increases the number.. The example underneath shows the result with the slider
on the left and on the right.
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3.2.3 Application

As mentioned above, marks are inserted based on the visible contents of the file. That means that
it if there are objects in the file which you do not want ai-cut to consider when placing marks, you
should remove them from the file or hide them from the Layers palette.

Marks may be inserted into any open space in the Artboard, this means paths that contain only a
stroke contain open space and may have marks placed inside them. Simply, if you show the Grid
from the View menu (making sure the Grids In Back preference is checked), any space within the
Artboard where the grid is visible, is a space into which a register mark may be placed.

Add Auto Marks should only be used when Illustrator’s Preview mode is active. If Illustrator is set to
Outline mode, regmarks may be placed inside objects, because Illustrator displays no filled spaces
when this mode is active.

Regmarks are automatically placed in a new layer named Regmark. As long as they remain in that
layer, each time you run Add Auto Marks, ai-cut will remove marks in the layer and replace them
with new marks reflecting your quantity selection. That means you do not have to remove the marks
manually if you would like to change the quantity, or have made any other changes to your file which
requires re-insertion of register marks.

Raster Images and Clipping paths are enclosed by a bounding box. Although these types of objects
may contain transparent space, they are treated as filled spaces by ai-cut. Therefore, it is a good
idea to insert register marks according to your vector cut paths, and not your final print objects. To
do this, simply hide the layers containing your print data before executing Add Auto Marks.
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3.3 Additional Tools

3.3.1 Add i-cut Layer

To generate a pre-defined i-cut layer, open the i-cut Layer window by selecting  Window > Esko >
ai-cut > Add i-cut Layer .

The window contains an i-cut Layer drop-down menu containing the list of available layer name
selections. Selecting any one of these choices and clicking OK will result in ai-cut adding a new blank
layer to your Layers palette; named according to your selection.

Placing your artwork, intended for finishing on an i-cut system, into layers with these pre-defined
names will allow your i-cut users to take full advantage of the i-cut template system, which can
greatly reduce their job setup time.

3.3.2 Preflight for i-cut

If you select  Window > Esko > ai-cut > Preflight for i-cut , the ai-cut plugin will perform a preflight
check on your file.

This check verifies that all layer names match those in the pre-defined list. If there are any
mismatches, a warning is displayed, which tells you which layer names do not conform.



3
ai-cut plugin

11

When all layers are named correctly, you will receive a message stating that the file is ready for i-cut.

The preflight check should be performed just before saving your cut file for i-cut.

3.4 Outputting files for i-cut and i-script

Once you’ve added registration marks to your file and transferred your cut paths to i-cut layers, you
will need to output your file.

If your job is going to be digitally printed and sent through any one of the many i-script compatible
RIPs, you will most likely be outputting for i-script. Taking advantage of the i-script workflow allows
you to send the cut information you have prepared to the RIP, which generates a cut file for i-cut when
the job is printed. This is very important because the file generated by the RIP reflects any changes
made in the RIP to the file you created. Possible changes include: Scaling, Tiling, Nesting, Rotation,
etc… Planning for these changes is made possible through the i-script workflow and dramatically
reduces setup and processing time when your file reaches i-cut.
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If your job is being printed with in traditional method, such as screen printing, or if it is being digitally
printed without an i-script compatible RIP, you will want to create a file specifically for i-cut.

3.4.1 Outputting for i-cut

Files output directly to i-cut should only contain the data required by i-cut to process the job.
Essentially, you are splitting your design file into two separate files, one which will be used for printing
the job, the other which will be used for cutting it.

Removing unnecessary data will reduce file size and avoid confusion. All print data, effects, raster
images, etc… should be removed from the file and the remaining data should be simply organized into
layers. Look at the example below. This file contains only two layers, one containing the registration
marks, the other containing the shapes that will eventually be through cut.

Once you have the file prepared, you can save it as in the native AI format or as a PDF. When saving
PDF files, be sure the Preserve Illustrator Editing Capabilities option is turned on. Failure to do so
could result in Illustrator’s output filter damaging your cut file to reduce file size.
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For more information on setting up files for i-cut, please refer to the i-cut User’s Manual.

3.4.2 Outputting for i-script

Creating files for i-script is slightly different than creating files directly intended for i-cut. In this case,
you are allowing your RIP to divide the file for you at a later point in time.

Empowering the RIP to be able to correctly output your cut file requires that you pass the cut file
data on to it in your print file. In order to identify objects and register marks as cut file data, you must
apply a specifically named spot color to the data you intend to cut. The exact color spot color name
which must be used varies, and depends on which RIP you are using.

Once the spot color or spot colors have been applied to the data in your file, you must save that
file in either the EPS or PDF format. When saving PDF files, be sure the Preserve Illustrator Editing
Capabilities option is turned on. Failure to do so could result in Illustrator’s output filter damaging
your cut file to reduce file size.

If you are using the EPS format, be sure to save the file as Postscript Level 3. This is required by
many RIPs to identify and separate spot colors from other print information in the file.

For more information on outputting files for i-script, please refer to the i-cut User’s manual, or to the
documentation that came with your RIP. To gain a better understanding of the i-script workflow, look
at the diagram below.
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4. Troubleshooting

Symptom Issue(s)
Regmark color does not update with the current
color when clicking the Use Current Color
button in the i-cut Register Marks window.

If the current color is a spot color, gradient,
pattern or some other type of fill, it cannot be
used by ai-cut as a regmark color. If you wish to
use one of these other types of colors for your
regmarks anyway, insert the marks and apply the
color afterward.

When using Add Auto Marks, Regmarks are
inserted inside print objects

1. Regmarks may be inserted into any open
space. Make sure you fill areas in which you
do not want regmarks inserted.

2. When Illustrator is in Outline mode, all
spaces are open. Regmarks should only be
inserted in Preview mode. You can change
the mode from Illustrator’s View menu.

When using Add Auto Marks, Regmarks aren’t
inserted close to cut paths of masked raster or
vector images.

Even though spaces within a clipping mask
appear to be open, they are treated by ai-cut as
filled space. For best results, hide these images
and show only their cut paths before inserting
marks.

When using Add Auto Marks, Regmarks aren’t
inserted close to cut paths of transparent raster
images.

Just like clipping masks, transparent areas of
raster images are treated as filled space. For
best results, hide these images and show only
their cut paths before inserting marks.
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